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Creating Proposals
In this course we will review the Clients, Vendors and Contacts interface, the Manage Projects Interface and
the process for creating a new project. We will thoroughly review the project setup process and once we
have created a project we will review the Project Editor interface in depth. We will then go through the
process of adding items to a project, analyzing project data and varies useful tools used for manipulating and
creating projects more efficiently.

Course Outline
Clients, Vendors and Contacts
o

Interface Overview

o

Adding Clients, Vendors & Contacts

Manage Projects
o

Manage Projects Interface Overview

New Project Setup
o

Creating a Project

o

Project Editor Tour

Creating a Proposal
o

Adding Products, Labor and Packages to a Project

o

Using Options & Alternates

o

Advanced Project Utilities (F&R, Update Similar, Clone, etc.)

o

Analyzing Your Project
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Clients, Vendors and Contacts
There are three entities, Clients, Vendors and Contacts. Clients are used for Project and Service Order creation.
Vendors are assigned to items and can be added to QuickBooks for use in Purchase Orders. Contacts can be
associated to Clients and Vendors or they can be "stand-alone". A Client can be a person or a business. Contacts
can be standalone entities, but also can be associated with specific Clients. The advantage to associating Contacts
with Clients is that when a project gets created for that client, the contacts are automatically imported into the project.

Manage Clients
Clients are a required element used to create projects and service orders. Clients and Contacts both can be added
during the process of creating a project or service order, or they can be created in advance.


New: Add a new client



Edit: Edit selected Client (or double click)



Clone: Copy selected client



Delete



Include Inactive (Yes/No)



Refresh



Export


CSV: Useful for exporting clients, editing the information and importing back into D-Tools – OR
for importing into other applications.



QuickBooks: Exports a Client record to QuickBooks. Note: QuickLinks Integration module is
required for this to operate. This also occurs during the first export of a project from D-Tools to
QuickBooks



Import


CSV: Import Clients from a CSV File



Outlook: Importing a Client from Outlook will create a contact record as well. Re-import will
update information in D-Tools from Outlook



QuickBooks: importing a client from QuickBooks does not create a contact like Outlook does.



Create Project: Creates a new project for selected Client



Create Service Order: Creates a new project for selected Client



Create as Contact: Pulls information from the Client record and creates a new contact
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Send Email: Opens an Outlook email for the selected client


Note: Client records do not have an email address; a primary contact must be assigned to the
client in order to use this feature.



Create Appointment: Opens an Outlook appointment for the selected client


Note: Client records do not have an email address; a primary contact must be assigned to the
client in order to use this feature.



Address Types: Manage the address types. When creating a client you can store multiple addresses
and the address types give you a method of defining different types of addresses such as billing/site.



View  Contacts: Switches to the Manage Contacts view.

Add a New Client (Manual)
1. Click New
2. General Tab: Enter Contact Information
3. Addresses: Add a billing address. Tip: If billing and site address are the same, only enter billing. DTools will auto-populate site address during project setup with the billing address if left blank.
4. Contacts: You can manually enter a contact here, or you can use the “Create as Contact” button on
the ribbon toolbar. Do not enter one right now.

Add a New Client (Import from Outlook)
1. Open your Outlook
2. Click the Import from outlook button on the toolbar.
3. A dialog box opens with all of your contacts.
4. You can select multiple if you wish from here. (Select All tool available)
5. Actions: Import or Cancel
6. Filters:
a. All
b. New
c.

Matched: These may already exist in D-Tools. If you re-import these it will update and
overwrite D-Tools with the latest information from Outlook.

Importing from QuickBooks follows the same process as Outlook.
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Implementation Tips

When importing a Client from outlook, a contact record is also created so it is recommended to import records
from Outlook as Clients when you intend to have them be a contact associated with their own client record. If
the contact is being imported so they can be attached to other clients, it would be recommended to import them
as a contact directly.

Add a New Contact for Client
1. Now that Your Client is created, let us create a contact record.
2. Select the Client in the grid.
3. Click “Create as Contact” button.
4. The Add new Contact form opens and you can populate the remaining information.
5. Click Save and Close.

Manage Contacts
Contacts are attached as sub-records to Clients. They are useful to store customer information but also helpful to
store contact information for other contractors working on your projects such as builders, electricians, consultants, etc.


New, Edit, Clone, Delete



Refresh



Export


CSV: Useful for exporting contacts, editing the information and importing back into D-Tools – OR
for importing into other applications.




Outlook: Exports a contact record to Outlook.

Import


CSV: Useful for importing contacts from CSV files.



Outlook: Imports a contact record from Outlook.



Create as Client: Takes information from the contact and populates it into a new client record.



Send Email: Opens an Outlook email for the selected contact.



Create Appointment: Opens an Outlook appointment for the selected contact.



Contact Groups: Contact Groups are useful to categorize your various contacts.



ViewClients & Vendors: Switches to the Manage Clients or Manage Vendors pages.
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Manage Vendors
The Vendors list in D-Tools can be used to manage the contact information for your various vendors. The list of
vendors can be used to assign the primary vendor for individual products in your catalog, and can also be exported to
QuickBooks to maintain a current vendors list there for purchasing. Both users with the QB interface and without will
find this feature useful.


New, Edit, Clone, Delete



Include Inactive



Refresh



Export


CSV: Useful for exporting Vendors, editing the information and importing back into D-Tools – OR
for importing into other applications.



QuickBooks: Exports a Vendor record to QuickBooks. This can also be accomplished when
exporting purchase Orders via QuickBooks integration.



Import


CSV: Useful for importing Vendor records from CSV files.



Outlook: Imports a Vendor record from Outlook.



QuickBooks: Import vendor information from QuickBooks.



Send Email: Opens an Outlook email for the selected contact.



Create Appointment: Opens an Outlook appointment for the selected contact.



View  Contacts: Switches to the Manage Contacts view.
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Manage Projects Overview
All of your projects can be managed using this one interface which gives you access to all the tools and resources you
need to interact with your project and conduct workflow tasks related to the project. The Manage Projects Interface
has five tabs on the ribbon and a section at the bottom of the page to view Files & Revisions.

Project Grid
The Project Gris is where you will select a project to open, run reports, review or make changes to it in some
way. The Project grid can be searched or filtered to find the specific project you are looking for. Once a project
is completed, many companies choose to archive the projects so the list is not so full of old projects. Archived
projects can be unarchived if they are to ever have changes made to them again. Projects can be sorted or
grouped using the column headers.

Home
Create


New  Project



New  Import Project: Import a project form an older version of D-Tools, or perhaps a
sample project.



New  From Mobile Quote: Create a new project from a Mobile Quote



New  From Template: Create a new project based on a template you have created.



Templates: Create and Publish project templates (includes products, labor and drawings) to
use when creating a new project. This can be used if you have projects with different tax rates
or different types of project settings for various projects like New Construction or Retrofit.

Open


Project Editor: This is the universal editor for creating and managing the items in your
project. Open in the editor when not needing to interact with drawings.
o

Double click a project in the grid will open in the project editor by default.



Project Information: Edit project information and settings here without opening the Editor.



Comments: Add date/time/user stamped comments to a project by various users.
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History: Project history tracks every time a project is checked out or checked into the server.
It also tracks changes to project level fields such as Project information or the project price.
o

Changed fields will not appear in history until a project is checked back into the server.

Files


Visio: Create new or Open any existing Visio drawings you have created.



AutoCAD: Create new or Open any existing AutoCAD drawings you have created.

Schedule


Calendar: Opens the company scheduling calendar.



Resource Hours: Opens the resource hours tracking interface.

Manage


Clone: Copy a selected project and create a copy.



Delete



Archive: Removes the project from the active projects list and sets it aside in the project
archive. Archived projects can be un-archived at any time.



Unarchive: Restore an archived project bask to active status.

View


All: Shows all Projects.



My: Shows only projects where your users is the “Project Owner”.



Archive: Filters the project list to only show Archived Projects.
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Filter


Quick Filter: Functions just like the catalog Quick Filter by:
o

Progresses

o

Clients

o

Resources

o

Assignees: This is the Project Owner field or “Assigned To”

o

Options: Checked in/out, etc.



Show Filter: Shows what the current filter is



Reset: Rests the filter



Search: There is a search bar to allow searching your projects list.

Server
Certain features will only be available for checked in or check out projects.


Check In: Check as project into the server



Check Out: Check as project out from the server



Get Latest Version: Retrieves latest files from server to local computer without actually
checking it out.



Undo Check Out: This is essentially an Undo command. It restores the server based project
(last version that was checked into the server) back to the state before you checked it out and
made changes.



Check In All: Checks in all projects at once. Does not check in other users projects.

Refresh
Other Tools


Force Undo Check out: This tool forces a project checked out by someone else to have the
undo check out command processed. This might be used if a user lost their laptop or their
computer crashed with a project checked out to it.



Rename Project File: Only way to rename the physical file name of a project.



Move: Only way to physically move a D-Tools project file. This might be used if you began
using a new local project folder directly after having had projects crated elsewhere.

Notes

Copyright © 2016 D-Tools Inc. |

SI Manual - Creating Proposals - 92

1850 Gateway Boulevard Suite 1060 Conc ord, CA 94520 Tel 925-681-2326 Fax 925-682-2900

Export
Send To


Zip: Exports the project and all of its files to a zip file. This could be used for backup or to
email a project to someone else. This allows you to save the zip to your computer.



Outlook: Zips the files and attaches them to an Outlook email.

Export


Excel: Exports the data in the project list to excel.



PDF: Exports the data in the project list to PDF.

Layouts


General: Shows typical project information



Resources: Shows project resources assigned to each project



Custom Fields: Shows custom fields in the grid



All: Shows all project fields available in the grid.



Custom: Create Custom grid layouts similar to what can be done in the Catalog Layouts.

Reports
Run and manage output of reports for various projects here. We will cover Reporting in detail during the
Reporting course.

Settings
The Settings tab provides access to project specific setup and configuration features. The specifics on these
were covered in the setup and configuration course.
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Project Tools (Bottom of Screen)
Files


Manage: When attaching files to D-Tools, both D-Tools generated files such as Visio or
AutoCAD drawings, you can assign them to a File category or subcategory. Create and
manage your file categories and subcategories as well as the order they are listed here.



New:
o

Visio Drawing: creates a new D-Tools Visio drawing file.

o

AutoCAD Drawing: creates a new D-Tools AutoCAD drawing file.



Add: Add a non D-Tools file to project, allowing you to browse your computer and select a file.



Open: Open selected file for editing/viewing.



Clone: Make a copy of a selected file.



Delete: Delete selected file.



Change category: Move a file to a different file category.



Rename: rename selected file.



Send To:



o

Zip: exports the selected file(s) to a zip file and saves to your computer.

o

Outlook: exports files to a zip file and attaches them to an outlook email.

o

Mobile Install: Attaches selected files to an existing mobile install task or service order.

Refresh: Refresh file list from server.

Revisions
The Revisions tab is where you can create, manage and compare project revisions. We will cover
Project revision in detail during the Revision Management course.

Tasks
Lists all of the tasks created for the selected project. This will be covered in detail in the Scheduling
course.

Service Orders
Lists all of the service orders created for the selected project. This will be covered in detail in the
Scheduling course.
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New Project Setup
When creating a new project we are guided through a wizard to ensure essential data is entered for each project.
There are only a few fields that are absolutely required to be entered before you open a project for editing, although
we recommend inputting as much as you can upfront.

Step 1 – Client Information




Client: A Client must be selected, you have the option here to create a client in one of three ways:


New (manual creation)



Import from Outlook



Import from QuickBooks

Project Name: The Project Name is what will print and display on the header of all reports and what your
project is referred to throughout D-Tools.



Project Number: This can be typed in manually or set using a Formatted number from Setup



Project Contact - This is the “Primary Contact” from the Client setup in Clients and Contacts


This will be pre-populated if a “Primary Contact” is designated for the Client



You can create a new contact here as well.



Client Number: Allows for assigning a Client Number to the project for searching, reporting, etc.



Progress: Assign the project’s progress or “status” here.



Price Type: This defines the default price type to be used in this project. Each item in a project can use
various price types, but selecting a default auto selects that price type by default.



Assigned To: This is where the “Project Owner” is designated



Start/End Date: You have the option to define start and end dates for your project once it is started and
once it has been completed.

Step 2 – Project Site Address
This is the Physical location of the project and contact information for that location. This information will prepopulate from the Client setup in Clients and Contacts. If you have multiple Site Addresses setup there it will
use the Primary Address of that type. You can copy the billing address here using the button. If the Client has
multiple addresses you can use the “Change” button to select a different address from the Client data.
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Step 3 – Project Billing Address
This is used for projects that have a different billing address than the site address for the project. You can click
“Copy Site Address” if they are the same. This information will pre-populate from the Client setup. If the Client
has multiple addresses you can use the “Change” button to select a different address from the Client data.

Step 4 – Define Price Rules for the Project
You now have a choice to set a default price rule for a project. This will apply the price rule for every item
added to the job. Example: If you are working a “Cost-Plus” bid, you can set a price rule for this cost plus
scenario and all items added to the job will automatically follow that rule. Nice!

Step 5 – Assign Project Tax Rates
Select how you would like to address taxes for this project. It will use your default settings from the Control
panel but you have the choice to use custom settings for each project here. See Setup course for more
information on Project Tax Settings.

Step 6 – Assign Project Resources
Assign internal resources for the project here. You can also create new resources from this interface. Adding
resources was covered in the setup course under Users Setup. Resources to be used in the Scheduling
module are not required to be added here.

Step 7 – Additional Project Contacts
Additional Project Contacts are used to store other external contacts related to the project. If contacts are
added as part of your Client setup in Clients and Contacts these contacts will be pre-populated here. New
Contacts can be added here from the Contacts list or you can create brand new contacts as well.
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Step 8 – Project Scope of Work
The scope of work can be used to track the project’s scope. There is a client report that can be run to present
this information to the customer. Snippets are pre-saved scope of work statements that can be reused again
and again. If you plan to use the scope of work for your projects you can configure a database of scope
statements to utilize and save time. NOTE: Once your project is created you will have the option of using a
“Rich Text Scope of Work” which allows for a Word Pad or Microsoft word document to be used for the scope of
work instead of this plain text scope of work editor. This is usually preferred as “rich text formatting” is possible.

Step 9 – Define Locations
This is where you define the Project Locations. The Locations are built using a hierarchy (up to five levels
deep) and consists of a series of Parent and Child Locations (Locations and Sub-Locations) to develop this
hierarchy.

Locations
Location must be built from the top of the hierarchy down. In our example we should create our areas
first. Then we can add rooms to those areas using the Sub-Locations option. To add locations from
your locations list created in the setup use the “Add from project Settings” button.
1. Areas to create
a. First Floor
b. Second Floor
c.

Landscape

2. Add typical rooms to each of the areas by selecting the Area you want to add the room to.
3. Practice organizing the order of the rooms.
4. The order of locations in this list will dictate the order they display on your proposal reports.

Implementation Tips

1. By configuring common location types in your D-Tools setup you can really streamline the project
creation process. Add all of the locations from the last five projects as a starting point.
2. Location Configurations: allow you to export an entire location setup so that it can be reused in the
future. This is an effective way to create location “templates” for reuse.
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Step 10 – Define Systems
Systems provide a secondary assignment method for products in the project. They create a way to allocate
items to their specific sub-systems in order to aid in project reporting and presentation to the client, filtering
items for analysis or documentation. There are many ways in which effectively using systems helps make your
process more effective. See the setup course for more information on systems setup in your database.

Step 11 – Project Contract Percentages
This is the default contract payment schedule from your company setup which can be edited on each project.
See the Setup course for more information on project contract settings.

Step 12– Project Custom Fields
Project Custom Fields can be used for many purposes. The Property names are renamed in the Setup
process. Custom Properties are typically used to store additional information not already tracked by D-Tools.

Save
When you are finished click Save to complete the project setup process. Your project will be created and
opened in the project Editor.
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Project Editor Overview
The Project Editor is the interface you will use to manage the items in your projects. The Editor has seven tabs on the
ribbon to help you work with your project data.

Home
View
Views provide you with different ways of looking at your project data. Some views are detailed and
others provide summary analysis. You will find them to be very helpful when working in your projects.




Summary Views: Provide a breakdown of the project pricing and profitability by:
o

Phase

o

Location

o

System

o

Item

o

Taxes

Detailed Views: Shows a grid layout of all products by:
o

Items: Shows all items

o

Packages: shows only packages

o

Misc. Items: shows only misc. items

Filters


Quick Filter: Functions just like the catalog Quick Filter by:
o

Options

o

Locations

o

Systems

o

Manufacturers

o

Categories

o

Phases

o

Vendors

o

Package Names

o

Estimate Numbers: Filter for items on specific QuickBooks estimates (if using
QuickLinks)
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o

Orders: Filter for items at various stages of order and installation.



Show Filter: Shows what the current filter is



Reset: Rests the filter



Search: There is a search bar to allow searching for specific items in your project.

Catalog
Add items from the catalog to the project which can also can be achieved via the Product, Labor and
Package Explorer on the left side of the interface.


Add  Products, Labor & Packages

New
Add new products to the project, will not automatically add them to your catalog. These are new items
added specifically for the project. They CAN be added to the catalog using the “Update To” function.


New  Products, Labor, Packages & Misc. Items

Package


Add To – New Package: Creates a new package and inserts selected items into package.



Add To – Existing Package: Selected items can be inserted into existing project packages.

Manage


Edit, Clone & Delete selected items from your projected.

Refresh


Sometimes after making changes to the data grouping, or mass updating, or assigning new
locations or systems to a large selection of items a refresh is necessary.

Open


Project Information: Edit project information that was populated in the project setup wizard.



Scope of Work: Create a plain text scope of work, create a “Rich Text Scope of Work” or
attached a previously created “Rich Text Scope of Work”. Also edit scope of work.



Comments: View and Manage project comments.



History: View project history tracking.
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Link


Mobile Quote: Select a Mobile Quote which has been synced to SI 2015 from an iPad
application. Allows you to begin building the detailed proposal from the Mobile Quote details.

Tasks


Update From: Updates information into project items from Task data. Such as installation
status, install date and install notes.

Tools
Replace
Brings up a window to select a replacement product, labor or package item for one(s) that you have
selected in the project grid.

Split Bulk Wire
Allows sales person to sell a specific amount of cable and not have to worry about specifying individual
runs of cable. The engineer or designer can then split up this "sold" cable into individual runs of cable
with their own cable ID, Head End, location, system, etc. If a wire is inside of a package, the location &
system assignments are locked unless the package setting for different locations/systems is enabled.

View Connections
View Connections will display any wire connection data for a selected wire. This is especially useful
when wires have been used on drawings in Visio or AutoCAD.

Promote
Allows for promotion of an alternate item to become the main item sold in the project.

Mass Update
Provides ability to perform mass updates on project fields. This tool works exactly the same way as it
does in the catalog. The difference is that the mass update tool inside a project allows you to update
various “project specific data fields”.

Price Rules
Brings up a window to select a replacement product, labor or package item for one(s) that you have
selected in the project grid.
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Similar Items
This tool allows you to update all similar product or labor items in a project (those with same
Manufacturer-Model) to match the configuration of the selected item. This is very useful if you have just
updated the data fields no one item and want to push those changes to all similar items.

Accessories
Perform a mass update on all selected items and add the same accessories to them all. Works the
same as the function in the catalog management, this tool just works within a project.

Alternates
Allows for mass update of multiple items to include specific products and labor as alternates.

I/Os
Update multiple items in the I/O browser at once. It is not a mass update tool but opens multiple items
for editing at once so I/O can be copied and pasted or compared.

Package Items
Add product and labor items to any selected packages in the project. This tool is very effective if you
have many packages in a project and need to modify them at once with the same new products/labor.

Order Status
Update the order status of items selected. There are three Order Statuses that we can assign to items
in our project: Not Ordered, Ordered, In Stock/Received. We will discuss this later in the course.

Install Status
Update the install status of items selected. There are three fields to be updated: Installed, Install Date
and Install Notes.
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Assign
Assign selected items to a new location and system or a location or system only. Also assign bulk wire
items to a Head End.

Regenerate
Will regenerate the component IDs for any selected items.

Discard
Discard (delete) optional and alternates items that are selected (or discard all)

Export Options
Items (Export to Excel)
Export all project data or only selected items to excel.

Wire Connections
Wire Connection data (from Visio or AutoCAD drawings) can be exported for all or selected wires
in the project. This gives you the ability to export these wires to excel along with all relevant
connection data so that wire checklists, labels, etc. can be created outside of D-Tools.

Send to SAP B1
Allows you to export project data to SAP Business One (If you have this enabled via D-Tools)

Bulk Update
Update from CSV
After selected items have been exported from a project, they can be re-imported with changes
made to the csv file. The Component ID is the field used to recognize which items are to be
updated, so do not change it!

Update Case
Provides a way to keep case settings for project items (Manufacturer, Category and SubCategory) in sync with the case settings on the server in case they were edited in either place.
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Catalog
Compare With
The Compare tool gives users the ability to compare project data with corresponding items in the
Catalog. The tool will allow you to see if there are any differences in price, labor, phase or any number
of fields so that you can identify differences between project and catalog. Data fields can then be
updated in either direction (to project from catalog or to catalog from project).

Update To Catalog/Update From Catalog
Push updated project data to the server database, or pull data from the server database in order to
update selected items in your project. Both have their uses in various types of situations.

Download
Opens D-Tools Data Browser

Update From
Provides ability to compare project items with D-Tools Library and will provide you with any fields that
are not in sync. This will show you what fields are different and allow you to choose which fields to
update into your catalog/project from the D-Tools library.

Reviews
Make a Data Review for a selected item.

Data Request
Make a Data Request from D-Tools (Data Subscription only)
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Layouts
Layouts are useful shortcuts that help you view specific database information quickly, making it easier to
perform mass updates and other database updates.


General: shows common fields to identify items.



Description: shows description oriented fields



Price: Shows pricing and labor related information



Accounting: Shows data specific to accounting/QuickBooks integration



Specifications: Shows specifications data (except I/Os)



I/Os: Shows Input and Output connection details



Order: Shows information related to Purchase Orders



Install: Shows project fields related to Installation status



Custom Fields: Shows all of the custom fields



Audit: Shows fields created to help audit the database



All: Shows all fields.



Custom: Shared with Catalog Custom Layouts

Options
Various options are provided to alter the display of items in the Project Editor grid.


Group by: Provides various options for grouping the data in the Project Editor.


None



Location



System



Location & System



System & Location



Group by Package: Groups items into their respective packages and non-package items.



Keep Accessories with Parent: Choose to keep accessories grouped underneath parent items or
broken out independently.



Hide Accessories: Check this box to hide accessory items in the grid.



Hide Alternates: Shows/hides alternate items



Allow Cell Editing: Choose to allow for in-cell editing in the project editor interface.
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QuickBooks
The QuickBooks tab provides tools to create QuickBooks estimates for items in your projects. You can also
manage the settings for your QuickBooks interface here. Layouts are useful shortcuts that help you view
specific database information quickly, making it easier to perform mass updates and other database updates.

Reports
Run and manage output of reports for your project here. We will cover Reporting revision in detail during the
Reporting course.

Settings
Project Settings inside the project Editor give you the ability to adjust the settings for this project to be different
than the global settings for Phases, Tax Rates, Wire Settings, Component ID format and Project Price
Adjustments. You can also manage the global project settings which give you the ability to set user
preferences for various aspects of working with projects.

Product, Labor and Package Explorer
These three interfaces provide the ability to add products, labor and packages to your projects. We will use this
interface shortly when we add items to our project.


Grid/Tree View: you can choose to organize your explorer in a grid or tree view.



New: Add new items to the catalog



Edit: Edit a selected item in the explorer.



Quick Filter: Apply filtering to narrow down the items in the list.



Query: Run queries on your explorer to narrow down the products in the list.



Docking: You can auto-hide the explorer, keep it docked or float it



Quantity: set a quantity for how many of the item you wish to add to the project.

(Products Only)
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Drop Zone
The drop zone is used for two things: adding items to the project and assigning them to a location and system,
or assigning an item already in your project to a location and system.


Add: When adding items to the project from the Explorer views, you can drag and drop them to the Add
box in order to add those items to the project.



Assign: Once an item is in your project you can drag it to the assign box and it will assign it to any
location or system you have selected.



Location/System: Both of the above functions work in conjunction with the location and system
assignments here. You also have the ability to add or edit locations and systems from here.

Right Click
The Right Click menu provides an easy ability to manipulate items in your projects. In General the right click
menu is very effective when wanting to make changes to specific items in the grid. Most of the right click menu
items are also located on the toolbar menus. There are a few that operate solely from the Right Click menu:


Mass Update [Field]: When you right click in a specific column location it will auto prompt you to mass
update that field, saving you some time.



Copy/Paste Items: You can select items and copy paste additional items.



Select/Deselect All



Expand/Collapse All
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Creating a Proposal
Adding Items to Your Project
There are several ways to add items to your projects, and depending upon where you are at in a project, what
specifically you are trying to do, one method might be more efficient/convenient than others.

Using the Explorer Views
I believe that using the explorer views is probably the most efficient manner of adding items to the project,
simply due to how quickly and easily you can access it and swap back and forth between products, labor and
packages. There are two methods of using the explorer to add items, one is to drag and drop to the “Add” box
in the drop zone, the other is to right click and select “Add to project”. I find right click to be a more streamlined
method of specification.

Exercise: Add Packages to the Project (Add Method 1)
1. First, choose which locations to add our package to over in the drop zone area on the right
2. Select System = Structured Wiring
3. Open the Package Explorer
4. Find the package called “Wiring – Structured - Multimedia”
5. Set the Qty = 1
6. Right Click  Add to Project
Note: You can use Ctrl + Left Click or Shift + Left Click to select multiple items to add.

Exercise: Add Packages to the Project (Add Method 2)
1. Leave the same locations and system selected from the last exercise (or reselect them)
2. Open the Package Explorer
3. Using Ctrl + Left Click select the following packages:
a.

Wiring - Structured – Dual Data

b. Wiring – Housewide A/V – (2) Spk/Ctrl
4. Set the Qty = 1
5. Drag and drop the packages inside the “Add” box on the Drop Zone interface.
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Using the Add Buttons
The Add buttons for products, labor and packages located on the Home toolbar also provides a second way to
add items into your project.

Exercise: Add Products to the Project (Add Method 3)
1. On the Home Tab click the button “Add Products”
2. Using the Quick Filter Select Category Type = Speakers
3. Choose Category = Speakers
4. Select Manufacturer = Sonance
5. Click Apply
6. Select Model = VP62R in the grid
7. Set Quantity = 2 (remember speakers must be specified as each in SI)
8. Select the proper locations and system in the lists below.
9. Click Add & Close.

Using the Clone Tool
If you have a products already in our project that you want to add elsewhere in the project, you can use the
clone tool to quickly duplicate the selected item or items.

Exercise: Add Products to the Project (Add Method 4)
1. In your project grid, select an item that you would like to duplicate
2. Right Click  Clone
3. When the Clone window pops up you will have three choices on how you want to proceed:
a. Keep cloned item in same location (unchecking allows you to select a new location)
b. Keep cloned item in same system (unchecking allows you to select a new system)
c.

How to deal with child items being cloned:
i. Clone as parent items
ii. Clone within existing parent or package item
iii. Clone complete package or parent item

4. Set your quantity, locations and systems as needed & Click OK
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Project Specific Data Fields
Once items have been placed in a project, there are database fields that become available that are not available in
the catalog because they are project and usually item specific.



Component ID: unique number assigned to every item product and labor item in a project



Serial Number: Place for entering the item’s serial number.



IP Address: Place for entering the item’s IP Address.



Optional: Clicking this box marks the item as optional. Its price will not be included in the overall
proposal price, and the item will be designated as an optional item in the proposal report.



Owner Furnished Equipment (OFE): Marks an item as being supplied by the customer and equipment
pricing is zeroed out. You still have ability to change labor and sell accessories however.



Non-Billable: This field is available in packages and accessories within the catalog, but it is not available
for standalone or parent items in the catalog. In the project however it becomes available. This is very
useful for items added to the project after the contract if items were forgotten or left out.


Non-Billable items do not apply selling prices for products or labor to the client, but do persist cost
values for product and labor in the project.



Discount: A discount percentage can be applied to an individual item in the project.



Net Unit Price: Net Unit Price can be derived as a result of applying the discount percentage, OR, the
net price can be set and the discount amount will be calculated to achieve that net price.



Accounting Estimate Number: The estimate number when the item was sent to QuickBooks.



Order Status: Track whether an item is Not Ordered, Ordered, Received/In Stock.



Order Number: Updated via QuickBooks integration or entered manually.



Ordered Date: The date something is marked as ordered.



Received Date: The date something is marked as received.



Install Status: Either installed or not. (Is updated by mobile installer module or manually)



Installed Date: Date an item was installed. (Is updated by mobile installer module or manually)



Install Notes: Install notes for each item. (Is updated by mobile installer module or manually)



Alternates: Alternate items are assigned much as the accessory items are assigned. Alternates are
different than optional items. Alternates are used as an alternate choice for the product and will display
as an “Add $xx.00 or Subtract $xx.00). A choice must be made which product is desired.
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Using Options & Alternates
One of the newest additions to SI is Options & Alternates, allowing users to propose optional proposal items (yes/no
decision by client) as well as propose alternate items (either/or decision by client). This is an excellent way to make
the proposal more robust without endless workarounds and processes such as we had to do in the past.

Adding Options
Adding an optional item to a project is very easy. You add it just like you would any other project item, except
once it has been added to the project, you edit the item, on the general tab you need to tick off the box for
“Optional”. Optional items are not included in the main price of the proposal to the client. They will be broken
out in a separate section of the proposal to make the client aware that it is an option.

Adding Alternates Method #1
The first way to add alternate items can be used for a single item or for multiple items. Alternates can only be
added to products.
1. Simply select the item(s) to which you wish to add alternates.
2. On the Tools menu select the “Alternates” tool.
3. Browse and choose which alternate products you wish to add to the item(s).
4. Choose whether to append or overwrite any existing alternate items.
5. Click Save.

Adding Alternates Method #2
The second way to add alternate items can be used for a single item only.
1. Simply select the item(s) you wish to add alternates to and open it up in the item editor.
2. Select the Alternates area of the item.
3. Browse and choose which alternate products you wish to add to the item(s).
4. Click Save. Adding alternates this way uses the “append option”.
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Adding Alternates Method #3
The third way of adding alternate items is via those alternates which were setup in the catalog for your items.
These will either be automatically added to the project as an alternate or you will be prompted, depending upon
your settings in the Global Project settings.

Formatting Choices for Options & Alternates


Project Editor Formatting: In the project Settings you can choose which color you would like the rows
highlighted for optional and alternate products. This is an excellent way to easily identify them when
working in the project editor. Easy to apply to the project.



Reports Formatting: In the Report Settings you have multiple formatting choices: you can identify the
text color to be used for options and alternates and you can also specify the text used to describe them
in their respective areas of the proposal display.

Advanced Project Utilities and Functions
Now that you know the main functions involved with creating a project, it is time to look into some more advanced
tools and utilities that will help you take your projection creation process to the next level.

Project Equipment Discounts
There are a few different ways of adding an equipment discount into a project. We will discuss the pros and
cons of each here.

Discount by Percentage (Entire Project)
You can use the Product Price Adjustments fields to offer a project discount with a percentage. These
fields are programmed to calculate their value based on a percentage of the equipment price in the
project. Using a negative percentage will allocate a discount.




Pros:
o

Easy to apply to the project.

o

Auto-adjusts itself as the size of the project price increases or decreases.

Cons:
o

Difficult to get a targeted discount price (i.e. $500).

o

The discount percentage perpetuates into the future on future revisions
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Discount by Percentage (Items)
You can use the new Discount field at the product level in the project. This field is found on the price
tab and is called “Discount”. A percentage discount can be applied for individual items, OR using Mass
Update you can apply the discount on multiple items at once.




Pros:
o

Provides flexibility for different percentage discounts for various items.

o

Discount amount will show in the project summary.

Cons:
o

Not as easy as applying a bulk discount across the entire project.

Using a Discount Line Item
You can also use an item in your database in order to apply a discount. For this to work you simply add
an item with a negative price. Be sure to have cost = 0.




Pros:
o

Easy to hit a target discount amount (i.e. $500).

o

Does not perpetuate into future revisions.

Cons: Does not auto-adjust with the size of the project.

Project Labor Discounts
Like equipment there are a few different ways of adding a labor discount into a project. We will discuss the pros
and cons of each here.

Discount by Percentage (Entire Project)
You can use the Labor Adjustment percentage (Settings  Price Adjustments) to offer a project
discount on the labor. Just use a negative percentage.




Pros:
o

Easy to apply to the project.

o

Auto-adjusts itself as the size of the project labor price increases or decreases.

Cons:
o

Difficult to get a targeted discount price (i.e. $500).

o

The discount percentage perpetuates into the future on future revisions.
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Using a Discount Labor Line Item
You can also use a labor item in your database in order to apply a discount. For this to work you simply
add a labor item with a negative price. Be sure to have cost = 0.




Pros:
o

Easy to hit a target discount amount (i.e. $500).

o

Does not perpetuate into future revisions.

Cons: Does not auto-adjust.

Replace Products
Replace products is a very useful tool for selecting a group of items in your project and doing a replacement of
all those items at once. It is much easier than deleting product and adding new product in their place. It can
also be used for one item at a time.
1. Filter the project editor for all speakers
2. Select two or three pairs of speakers in the list from various locations using Ctrl + Left Click
3. Right Click  Replace Products
4. Now you have a product selection window and can search to find a suitable replacement
5. Before you replace the items you may want to consider two options you have:
a. Maintain Component IDs: Keeps the same component ID for the new item
b. Maintain Installation Prices: Keeps same installation price as the item it is replacing
c.

Keep Accessories: Keeps the current accessories from the item being replaced.

d. Keep Alternates: Allows you to keep any alternates assigned to the replaced product.
6. Once you have selected an item click Replace and Close.
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Update Similar
The update similar tool is designed to make keeping edited items in your project up to date. For example if I
edit the price on a speaker, this tool enables me to quickly and easily update all of the other similar speakers in
the project with this price change.
1. Choose one of the speakers in the project.
2. Navigate to the layout tab = Price
3. Edit the Unit Price for the speaker
4. Select the speaker that was updated
5. Right Click  Update Similar Products
6. Now you are presented with a list of fields to choose which will be updated.
7. Click Deselect All
8. Select ‘Prices’
9. Click OK – you will be prompted with the number of similar items that were updated.

Update from Catalog
You also have the ability to update items in the project from the data in the catalog. Because there is clear
separation between Catalog data and project data, your project is not automatically updated when you update
the catalog. From time to time you may find that the data in your catalog has become more accurate than the
data in your project. For example if someone were to edit the IO for a specific item and you want to pull that
data into your project OR you wanted to refresh pricing on a project created several months ago.
1. Choose an item in your project (multiple can also be selected at once).
2. Right Click  Update From Catalog  Products.
3. You have the opportunity to select which fields to pull into the project using the Options drop
down. It is essential to use the Options carefully because you may not want to update the pricing
in your project for example.
4. Once you are ready, click Update.
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Update to Catalog
The Update To Catalog function works exactly opposite from the Update from Catalog feature. You would want
to use this for example if you had updated data in your project and wanted to push those changes to the catalog
for the future.

Mass Update Items into Packages
This tool (Package Items tool on Tools tab) provides the ability to select a single or multiple packages and insert
additional items into them all at once without individually editing each package. For example if you realized
after specifying packages throughout the project that they all needed an additional cable.
1. From the Home tab, select View  Packages.
2. This shows you a list of all the packages in your project.
3. Using Ctrl/Shift + Left Click select the packages you want to update.
4. Go to the Tools tab on the ribbon.
5. Select the Package Items button.
6. Click Add Products.
7. Select a product from the catalog.
8. Make a choice for how you want to deal with the additional items.
a. Append
b. Overwrite
9. Choose Append so we can just add the product to the rest of the items in the packages.
10. Click Save.

Copying Items from One Project to Another
D-Tools SI 2015 has the capability to copy and paste data back and forth between two different projects! This
gives us amazing flexibility to leverage work we have completed before on other projects. For example if I
wanted to reuse the equipment head end from another project – all of the hardware, racks, cables, etc. I can
open the other project and simply copy and paste the data into my new project. There are a few considerations
to be aware of though:


When you copy and paste items it is easiest to drag and drop selected items from one project
to the other. Copy and Paste works too.

Notes

Copyright © 2016 D-Tools Inc. |

SI Manual - Creating Proposals - 116

1850 Gateway Boulevard Suite 1060 Conc ord, CA 94520 Tel 925-681-2326 Fax 925-682-2900



In Visio – it is better to use the “insert drawing pages” function as it allows you to insert not
only the items on the page, but also any accessories or package items associated with the
items on the drawings. (You can copy/paste specific shapes from Visio, but it will ignore any
related items not selected for copy/paste.)

Analyzing Your Project
Once you have begun creating a project you have various tools and resources available to help you analyze the
information in your project.

Using Views
The project views (both summary and detail views) provide excellent ways to view your project from different
angles. Knowing what each of them provides can be very helpful to you when you need to analyze your project
in detail. Specifically, I find that using these views reduces the need to run specific reports for analysis.

Phase Summary View
1. From the View menu, select the Phase view
2. You are provided with summary numbers for equipment and labor pricing as well as margins.
3. By clicking on the phase name you can drill down to the specific items in that phase and view the
numbers associated with those items, searching for any with issues.
4. Click the return button to return back to the original view.
5. Tip: Look for Phase – “Unassigned” – remember that items without a phase will not charge for
labor!

Other Summary Views
The other views will also be helpful to you as well:
1. Location
2. System
3. Items
4. Tax
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Using Filters
There are a few filters I find to be excellent resources to help analyzing my project before submitting a proposal.

Quick Filter
1. From the Layouts menu select the Pricing layout
2. From the Home menu choose Quick Filter  Options
3. There are two choices on this menu that are very effective for project analysis:
a. Items with Zero Cost
b. Items with Zero Price
c.

Items with Zero margin & Markup

4. Utilize these one at a time, otherwise it looks for items meeting both criteria). This will help you
to identify any items missing pricing and help you to fix any errors.

Column Filters Example #1
1. From the Layouts menu select the Pricing layout
2. Each column shown in the grid has the ability to be filtered and can assist in finding unwanted
values.
3. Click the filter button on the Unit Cost column
4. Deselect the All checkbox so that none of them boxes are selected
5. Select the box next to $0.00
6. You have now filtered for items with zero cost and can fix them.

Column Filters Example #2
1. From the Layouts menu select the Pricing layout
2. Click the filter button on the Phase column
3. Deselect the All checkbox so that none of them boxes are selected
4. Select the box next to ”Blanks”
5. You have now filtered for items with blank phases and can fix them.
6. It is very important to identify any items in your project that do not have a phase assigned. The
labor pricing is stored with the phase, and if a phase is blank you will not be charging for that
item’s labor.
NOTE: Use the column filtering for other critical fields you want to verify such as Unit Labor Hours or Taxable
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Compare With Catalog
The Compare with Catalog tool provides the ability to compare project items with their corresponding records in
the main catalog. This can be an extremely useful tool on projects for numerous reasons: To check project
pricing against the catalog (and update it one way or the other…), and it can also be used to check various
other fields. Managers can compare projects to be sure sales staff have not reduced or changed pricing on
items in their project as well.

1. Select an item or items in the project editor
2. From the Catalog menu select Compare With Products or Labor
3. Select the specific fields you wish to compare from the project to the catalog
4. If the items are different you will be presented with the project Value and the SI 2015 value
5. You can then:
a. Update from Project to Catalog
b. Update from Catalog to Project
c.

Edit the item

d. Filter for Similar, Dissimilar or All items

Resolving Issues Found During Analysis
When you find issues in the project that need to be resolved there are a few useful tools you can use.

Mass Update
1. When you have multiple items to resolve (and all of them have the same field to be updated
with the same value) use the mass update tool.
2. Example: Items that are not marked taxable (and need to be).
3. Select all of the items found using your filtering.
4. Choose Mass Update.
5. Select Taxable Field.
6. Check the box and click save.
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In Grid Data Entry
1. Sometimes you have one or two items that need to be resolved (for example an item that is
missing a price). Certain fields in the grid can be updated, but not all.
a. Unit Cost
b. Unit Price
c.

Labor Hours

d. Margin
e. Markup
2. Simply type into the grid to enter the data.
3. You will see an edit icon with a pencil in the column header if the item can be edited.
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